1. Introduction ......................................................................................................................... 1
2. Creating an OpenShift Application .................................................................................... 3
3. Import an existing application ........................................................................................... 17
4. Modifying your Maven Web Application to Deploy to OpenShift ..................................... 25
5. Port Forwarding .................................................................................................................... 27
6. Debugging ........................................................................................................................... 29
   6.1. Viewing the Remote Console ......................................................................................... 29
   6.2. Viewing Environment Variables ................................................................................... 30
7. Deleting applications and domains .................................................................................... 33
   7.1. Deleting an application ................................................................................................ 33
   7.2. Deleting a domain ......................................................................................................... 34
Chapter 1.

Introduction

OpenShift is a cloud solution for your application server requirements. OpenShift is a cloud-based application platform for Java, Perl, PHP, Python, and Ruby applications. JBoss Developer Studio supports OpenShift deployments and this guide will show you how to connect, create and deploy applications with OpenShift, from your workbench.
Creating an OpenShift Application

The **OpenShift Application** creation wizard is accessed through **JBoss Central** or by navigating to **File → New → Other**.

![figure 2.1. selecting the openshift application wizard]

After clicking on the **OpenShift Application** link, the creation wizard will launch.
Sign in to OpenShift

Please provide your OpenShift credentials.

If you do not have an account on OpenShift, please sign up here.

Username: username
Password: ********

☐ Save password (could trigger secure storage login)

Figure 2.2. Input OpenShift credentials
If you have already signed up for an OpenShift account then you can input your **Username** and **Password** here and click the **Next** button. If validation is successful you will see the **Setup OpenShift Application** screen.

If you do not have an OpenShift account, you can create one through the link at the top of the wizard screen. This will open the OpenShift sign-up page within your workbench. Once you have created an account you will need to relaunch the **OpenShift Application** wizard and input your new username and password.

---

**Figure 2.3. Creating a domain**

If you need to create a domain, type the name you wish to have into the **Domain name** field. You will also need to provide your public SSH key. Ensure that the paired private key is listed within the SSH2 Preferences. If you are unsure, click the **SSH2 Preferences** link. Click **Finish** to complete domain creation.

If you already have a domain name then you will not see the **Domain Creation** screen.
Note

If you ever wish to rename your domain, this can be done through the OpenShift Explorer.
Setup OpenShift Application

Select an alphanumerical name and a type for the application to create.

- Use existing application: [ ]

New application

Name: 

Type: 

Gear profile: 

- Enable scaling [ ]

Embeddable Cartridges

- mongodb-2.0
- cron-1.4
- mysql-5.1
- postgresql-8.4
- haproxy-1.4
- 10gen-mms-agent-0.1
- phpmyadmin-3.4
- metrics-0.1

Figure 2.4. Creating a new OpenShift application
Chapter 2. Creating an OpenSh...

Now ready to create your OpenShift application, you will need to specify a name, the platform type to deploy for, from the **Type** drop-down list, and the **Gear profile** to be used.

The **Gear profile** option concerns the amount of physical space that will be allocated for use by the application. If you are running a trial version of OpenShift only the **small Gear profile** will be available to you.

**Note**

No underscores or special characters are allowed in the application name.

You can also select to embed cartridges into your application. By embedding a cartridge, you allow your application the ability to use the associated technology. For example, embedding the **mysql** cartridge will grant your application the capability to use a MySQL database.
Setup Project for OpenShift Application "jbossas"

Configure your project and server adapter settings, then click 'next' or 'finish'.

☑️ Create a new project

Use existing project: [Input Field]

Server Adapter

☑️ Create and setup a server for easy publishing

Figure 2.5. Application setup
Chapter 2. Creating an OpenSh...

Since you are creating a new project, leave the **Create a new project** checkbox ticked.

For easy interaction with the OpenShift server and your domain it is recommended that you leave the **Create and setup a server for easy publishing** checkbox ticked. Doing so will create an OpenShift server instance in the **Servers** view, upon completing the wizard.

Click the **Next** button to progress in the wizard.
Import an existing OpenShift application

Configure the cloning settings by specifying the clone destination if you create a new project, and the git remote name if you’re using an existing project.

**Cloning settings**

- Use default location
  
  **Location:** /home/irooskov/git
  
  **Remote name:** origin

Make sure your SSH key used with the domain is listed in SSH2 Preferences.

Figure 2.6. Cloning settings
Chapter 2. Creating an OpenSh...

The final screen of the OpenShift application wizard specifies Cloning settings. Here you can set the properties for creating a local copy of your application. The Location and Remote name options will be set automatically, however, you are able to change these by deselecting the default option and specifying custom settings in the fields provided.

Click the Finish to begin the cloning of the Git repository.

Figure 2.7. Project added to available Git repositories

After the Git repository has been cloned, it will be available through the Git Repositories view. You can open it by navigating to Window → Show View → Other → Git → Git Repositories. With the Git Repositories option selected, click OK.
Figure 2.8. Project in Project Explorer

The OpenShift application that you created through the wizard, will appear in your Project Explorer tab.
Figure 2.9. Publishing your project through the server adapter

The wizard has also created a server adapter that connects to your OpenShift service. In the Servers tab there will be an OpenShift server available that contains your application. Any changes you make locally to the application can be published to your OpenShift instance by right-clicking on the application under the server in the Servers view, and selecting Full Publish.
Figure 2.10. OpenShift server overview and settings
As with a local server, double-clicking on the OpenShift server instance in the **Servers** tab will open the server overview page in your workbench.

**Figure 2.11. OpenShift Explorer view**

The OpenShift application will also be available under your domain in the **OpenShift Explorer** view.
Import an existing application

To import an existing OpenShift application to your workbench, from JBoss Central navigate to the Create Projects section and click on OpenShift Application.

Figure 3.1. Selecting the OpenShift Application wizard

Enter your OpenShift credentials and click the Next button.
Sign in to OpenShift
Please provide your OpenShift credentials.

If you do not have an account on OpenShift, please sign up here.

Username: username
Password: ********

☐ Save password (could trigger secure storage login)

Figure 3.2. Input OpenShift credentials
On the **Setup OpenShift Application** screen click the checkbox beside *Use existing application* and click the **Browse** button.
Chapter 3. Import an existing...

Setup OpenShift Application
Please select an existing OpenShift application

**New application**

- **Name:**
- **Type:** jbossas-7
- **Gear profile:**
- **Enable scaling**

**Embeddable Cartridges**
- 10gen-mns-agent-0.1
- cron-1.4
- haproxy-1.4
- jenkins-client-1.4
- metrics-0.1
- mongodb 2.0
- mysql-5.1
- phpmyadmin-3.4

**Figure 3.3. Setup OpenShift Application screen**
A dialog will open where you will see all your OpenShift applications listed, for the current domain.

**Select an application in the list**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>jbossas</td>
<td>jbossas-7</td>
<td><a href="http://jbossas-iroskovdomain.rhcloud.com/">http://jbossas-iroskovdomain.rhcloud.com/</a></td>
</tr>
<tr>
<td>jbossas2</td>
<td>jbossas-7</td>
<td><a href="http://jbossas2-iroskovdomain.rhcloud.com/">http://jbossas2-iroskovdomain.rhcloud.com/</a></td>
</tr>
</tbody>
</table>

**Figure 3.4. Existing applications on OpenShift**

By selecting an application from the list and clicking the Details button you can see all relevant application information. Click the OK to return to the application selection screen.
Chapter 3. Import an existing...

Details of Application jbossas2

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>jbossas2</td>
</tr>
<tr>
<td>Public URL</td>
<td><a href="http://jbossas2-irooskovdomain.rhcloud.com/">http://jbossas2-irooskovdomain.rhcloud.com/</a></td>
</tr>
<tr>
<td>Type</td>
<td>jbossas-7</td>
</tr>
<tr>
<td>Created on</td>
<td>2012/06/13 at 14:39:46</td>
</tr>
<tr>
<td>UUID</td>
<td>c3bdddcc1c1d4e6a94884b9cfdebf4f</td>
</tr>
<tr>
<td>Git URL</td>
<td>ssh://c3bdddcc1c1d4e6a94884b9cfdebf4f@jbossas2-irooskovdomain.rhcloud.com/</td>
</tr>
<tr>
<td>Cartridges</td>
<td></td>
</tr>
</tbody>
</table>

Figure 3.5. Details of OpenShift application

Select the application to import and click the OK button.

You will be returned to the Setup OpenShift Application screen and the Use existing application field will be populated with the name of the application you selected.
Setup OpenShift Application

Select an existing or create a new OpenShift Application.

- Use existing application: jbossas2

New application

- Name: jbossas2
- Type: jbossas-7
- Gear profile: small
- Enable scaling: 

Embeddable Cartridges:

- 10gen-mms-agent-0.1
- cront-1.4
- haproxy-1.4
- jenkins-client-1.4
- metrics-0.1
- mongodb-2.0
- mysql-5.1
- phpmyadmin-3.4

Figure 3.6. Setup OpenShift Application screen
To complete importing the application click the **Next** button and continue follow the instructions after the **Setup OpenShift Application** screen that are available in the *Creating an OpenShift Application* chapter: *Figure 2.6, “Cloning settings”*. 
Modifying your Maven Web Application to Deploy to OpenShift

Open the pom.xml file of your web application in the editor by double-clicking on the file in your Project Explorer and selecting the pom.xml tab in your workbench.

Create profiles tags within the project tags of the pom.xml file. Within the profiles tags, press Ctrl and Spacebar together to trigger auto-completion.

From the auto-completion menu, select OpenShift profile. The profile information to connect to OpenShift will be inserted.
Figure 4.1. Selecting the OpenShift Profile
Port Forwarding

Port forwarding is available for each OpenShift application. To access port forwarding for an application right-click on an application in the OpenShift Explorer view tab and select Port forwarding from the context menu.

Figure 5.1. Port forwarding option

The Application port forward dialog will display ports that can be forwarded. To forward all ports click the Start All and the Stop All button will stop port forwarding for all listed ports.

If you do not wish to use the remote port numbers selected by default, click the checkbox beside the Find free ports for all Services option.

The default local address is set to 127.0.0.1 and if the remote port is not available a random one will be generated. If your operating system supports it, you can uncheck Use 127.0.0.1 as the local address for all services and the local address will become the same as the remote address.
Chapter 5. Port Forwarding

Application port forward

Please configure port forwarding for the 'jbossas' application

<table>
<thead>
<tr>
<th>Service</th>
<th>Local Address</th>
<th>Local Port</th>
<th>Remote Address</th>
<th>Remote Port</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>java</td>
<td>127.0.0.1</td>
<td>4447</td>
<td>127.8.190.1</td>
<td>4447</td>
<td>Stopped</td>
</tr>
<tr>
<td>java</td>
<td>127.0.0.1</td>
<td>8080</td>
<td>127.8.190.1</td>
<td>8080</td>
<td>Stopped</td>
</tr>
</tbody>
</table>

✔️ Use '127.0.0.1' as the local address for all Services

☐ Find free ports for all Services

Figure 5.2. Port forwarding dialog
Chapter 6.

Debugging

This chapter covers useful tools for debugging OpenShift servers and applications.

6.1. Viewing the Remote Console

Similar to when you are running a server locally, you are also able to see console output for your remote OpenShift server. To have this output displayed to you, right-click on your OpenShift application in the OpenShift view tab, and select Tail files.

A new tab will open called Console and display the last 100 lines of the servers boot.log and server.log files. This Console tab will now tail the content of these files on the server, outputing any updates to you, as they occur.
Figure 6.2. Viewing OpenShift server console output

This information can be useful in ensuring processes are executing as expected.

6.2. Viewing Environment Variables

You are able to view the environment variables that an OpenShift application is utilizing and the current content of each variable. To have this output displayed to you right-click on your OpenShift server in the OpenShift view tab, and select Environment Variables.
Figure 6.3. Selecting the Environment Variables menu item

The output will appear in the Console view tab.
Chapter 6. Debugging

Figure 6.4. Viewing OpenShift application environment variables

This information can be useful in ensuring an application is receiving the correct environment variable values.
Deleting applications and domains

This chapter explains how to remove applications and domains from OpenShift.

7.1. Deleting an application

Deleting an application will only remove it from the OpenShift server. The application and OpenShift server adapter will remain in your workbench.

To remove an application right-click on it in the OpenShift Explorer view tab and select Delete Application(s) from the context menu.

Figure 7.1. Delete Application(s) menu item

A dialog window will display asking you to confirm the action and alerting you that you will not be able to recover the application once it has been deleted. Click the OK button to delete the application.
You are about to destroy the “jbossas” application. This is NOT reversible, all remote data for this application will be removed.

Figure 7.2. Confirming application deletion

Once the application has been deleted you will notice that it has been removed from the list of applications available on your OpenShift server.

Figure 7.3. Application removed

7.2. Deleting a domain

To delete a domain right-click on your server connection in the OpenShift Explorer view tab and select Delete Domain from the context menu.
Deleting a domain

Figure 7.4. Delete Domain menu item

A dialog box will be displayed asking you to confirm domain deletion. As a domain can only be deleted if it has no applications associated with it, an option is available to **Force applications deletion**. By selecting this checkbox any applications still associated with the domain will be deleted and unrecoverable.

**Warning**

It is recommended that you remove applications individually before deleting a domain to ensure you have created a copy of any application data you wish to keep.

If you do not select the **Force applications deletion** option and the domain to be removed still has an application associated with it, domain deletion will fail.

Figure 7.5. Confirming domain deletion
Once the domain has been deleted the connection to OpenShift will remain, however the **Delete Domain** option will not be available from the context menu.

![OpenShift Explorer](image)

**Figure 7.6. Delete Domain option not available**